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Introduction 
The Benefit Self Service for Microsoft Dynamics GP® product was created to provide 
enhanced capabilities to the Employee Self Service product for Business Portal for 
Microsoft Dynamics GP. More specifically, Benefit Self Service enhances the benefit 
options for the employee by adding eligibility rules, enrollment and extended benefit 
set up capabilities to administrators of the benefits. 
 
Benefit Self Service provides the following features: 
• Provides employee level access and entry point for employees to access their 

personal information and existing benefits and to participate in open enrollment 
periods. 

• Provides HR Administrators with configuration options for eligibility, enrollment and 
related administration of all benefits. 

 

What is in this manual? 
This manual provides a single source of information for learning about procedures and 
features that are included in Benefit Self Service. The manual is divided into a separate 
part for each module based on the employee’s role. 
 

Part 1: Employee 
This part provides instructions for the use of the enhanced features contained in the 
Benefit Self Service product. The pages that are included in this part of the manual 
include: 
• Benefits Summary 
• Benefits Enrollment 
 

Part 2: Human Resources 
This part describes the concepts needed for HR Administrators to obtain functional 
knowledge from the Benefit Self Service product. The Web Parts that are included in 
this part of the manual include: 
• Benefit Rights 
• Benefit Packages 
• Eligibility Rules 
• Annual Open Enrollment Setup 
• Employee Enrollment Setup 
• Benefit Enrollment Summary 
• Post Employee Enrollment 
• Post Annual Open Enrollment 
• Delete Enrollment Utility 
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Part 3: HR Setup Requirements 
This part describes the setup requirements needed to enable all functionality and 
features of the Benefit Self Service product. The setup requirements included in this 
part of the manual include: 
• E-mail Setup 
 

Part 4: Employee Dependents and Beneficiaries 
This part describes how employees access and update the Dependents and Beneficiary 
pages. Both functions can be linked to individual benefit codes by the Human Resources 
Administrator to be included in the enrollment process. During the Annual or Employee 
Enrollment process, employees will have the option to select the specific benefit codes 
linked to a dependent and/or beneficiary. 
 

Symbols and conventions 
This manual uses the following conventions to refer to sections, navigation and other 
information. 
 

 The light bulb symbol indicates helpful tips, shortcuts 
and suggestions. 
 

 The warning symbol indicates situations you should be 
especially aware of when completing tasks. Typically, 
this symbol includes cautions about performing steps 
in their proper order, or important reminders about 
how other information in Microsoft Dynamics GP may 
be affected. 

> 
Example: File > Print 

The (>) symbol indicates selections to make from a 
menu. In this example, from the File menu, choose 
Print.  
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Part 1: Employee 
The information in this part describes how the employee will access the Benefit Self 
Service pages by choosing Employee > Benefits from the Business Portal menu. This 
option will be available based on the access rights configured for this employee by the 
Business Portal Administrator. When granted access, employees can view their specific 
benefits, change certain data elements and enroll in or waive benefits they are eligible 
for. Benefit types available will include Health, Life, Retirement and Miscellaneous 
benefits. 
 
• Chapter 1: Benefits, is available to any employee assigned to the Employee role in 

Business Portal. 
• Chapter 2: Benefits Summary, enables the employee to view their existing benefits 

and additional benefit information. 
• Chapter 3: Benefits Enrollment, allows the employee to make selections via a wizard 

to enroll in benefits. 
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Chapter 1: Benefits 
The Benefits page can be accessed in Business Portal by choosing Employee > Benefits. 
 

Employee Benefits Overview 
The Benefits page will be displayed when you choose Employee > Benefits in Business 
Portal. To gain access to this menu option, the employee must be assigned an eligibility 
rule. If they do not have an eligibility rule assigned to them, they will receive a 
message telling them that they are not assigned to an eligibility rule. 
 

 

 
The Benefits page consists of the following web parts. Each of these web parts will be 
described in more detail later in this document: 
 
The Benefits Summary Web Part will allow an employee to view all of their current 
benefits by benefit code. The benefit description will be listed for the employee to take 
a quick look at their current benefit enrollments. This web part will also contain an 
Existing Benefit link that will open the Benefits Summary page. This page provides drill-
down capabilities to provide access to the individual benefit code definitions and 
associated benefit information. The employee will see both benefits that they enrolled 
in and those that may be assigned to them by the human resources (HR) department. 
 
The Benefits Enrollment Web Part is the launch point for employees to select 
benefit options during open enrollment periods, such as Annual Open Enrollment or 
Employee Enrollment. The Annual Open Enrollment is used to support a companywide 
enrollment program once per fiscal year. Employee Enrollment is used when the 
employee has a life event or position change that requires changes in benefit 
selections, as well as for new or rehired employees. This web part will contain text 
welcoming the employee to the enrollment period (created by HR), a brief reason that 
enrollment is currently open to them and the timeframe for which enrollment will be 
open to them to make their selections. This includes a start, end and effective date. 
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The text, reason and timeframe displayed is defined on the Human Resources Center > 
Benefit Self Service Center Pages > Annual Open Enrollment Setup and/or Employee 
Enrollment Setup pages. The web part will contain a link specific to either the Annual 
Open Enrollment or Employee Enrollment options that, when clicked, will open the 
Benefit Enrollment page. The employee could have both links open and available to 
them at the same time, as defined during the setup. 
 
In this section, the employee could see the message, “You are not eligible for any 
benefits. Please contact your HR Administrator for assistance.” if the employee is not 
currently assigned to an eligibility rule (defined later) by their HR Administrator. 
 
However, if the employee is assigned to an eligibility rule and no enrollment periods are 
set up for the employee on either the Annual Open Enrollment or the Employee 
Enrollment, the employee will see text stating, “No open enrollment options are 
currently available for you.” 
 
Employee current eligibility is automatically verified each time they enter either the 
Annual or Employee Enrollment options based on the conditions defined here. When the 
employee clicks either link, there are several eligibility validations that take place. The 
only way to avoid automatic enrollment assignment is to set the employee eligibility to 
Override (defined under the Employee Eligibility Tool section). 
 
If the employee’s current eligibility passes all the validations, the employee will be 
automatically assigned and allowed to proceed with enrollment with no messages. 
 

 If the employee does not pass all the validations, the employee will receive one 
of several messages: 

If the employee is marked as Override but is not currently assigned to an 
eligibility rule, they will receive the message, "You are not eligible for any 
benefits. Contact your HR Administrator for assistance." 

If selections were made for the current enrollment period and then the 
employee’s eligibility has changed, they will receive the message, “Your 
eligibility has changed since you made your selections. You cannot access 
Benefit Enrollment until those selections have been posted.” 

 

 To resolve this conflict, the HR Administrator will need to use the Human 
Resources > Delete Enrollment Utility to remove the outstanding benefit 
selection records or, if appropriate, post any outstanding benefit selection 
records for that employee. 
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If the employee does not pass all validations and they have not received one of the 
messages above, they will receive the following message and marked as in “Conflict.” 
 
• If the employee is not marked as Override and has no outstanding benefit 

selections. 
• An employee is assigned to an eligibility rule and is no longer eligible for the same 

eligibility rule(s) as they were when their eligibility rule was assigned. 
• An employee is not assigned to an eligibility rule and is not eligible for any eligibility 

rules. 
• An employee is not assigned to an eligibility rule and is eligible for more than one 

eligibility rule. 
 
They will receive a message, “There was a conflict while determining your benefit 
eligibility. The HR Administrator has been notified. Contact your HR Administrator for 
assistance.” All employees assigned to the Human Resources Administrator role will be 
sent an e-mail notification. 
 

 When an employee eligibility conflict is resolved using the Employee Eligibility 
Tool, the employee will receive an e-mail notification that their eligibility conflict 
has been resolved. 

 
Summary of conditions that must be met for an employee eligibility to be 
automatically assigned: 
• An employee must be assigned to an eligibility rule. 

Note: An employee will be automatically assigned to an eligibility rule when they 
access the Benefit Enrollment link(s), as long as no eligibility conflicts are found. 

• An employee is assigned to an eligibility rule and is still eligible for the same 
eligibility rule(s) as they were when their eligibility rule was assigned. 

• An employee is assigned to an eligibility rule and, although they are eligible for 
different eligibility rule(s) than when their eligibility was assigned, they are still 
eligible for the eligibility rule they are assigned to. 

• If an employee is set to Override and an eligibility rule has been assigned, even if 
eligibility had changed, no eligibility will be verified. 

 

 Any benefit enrollment selections that have been selected or submitted but not 
yet posted will be deleted if an employee’s eligibility is automatically changed 
without conflict. For e-mail notification to be successful, all e-mail settings must 
be set up and the Employee – Profile e-mail address must exist for the employee. 
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Example of an e-mail sent to the HR Administrator when an employee is set to 
in “Conflict”: 
 

From: someone@example.com 
Sent: Monday, July 19, 2004 4:12 PM 
To: someone@example.com 
Subject: Employee Eligibility Conflict 
 
The following employee has an Eligibility conflict. Please resolve this Eligibility 
conflict using the Employee Eligibility Tool. 
 
Employee ID:  DIAZ0001 
Employee Name: Diaz, Brenda 

 Currently Assigned Eligibility: ER2 -- Eligibility Rule 2 
 Was Eligible For: ER1 -- Eligibility Rule 1 
    ER2 – Eligibility Rule 2 
    MANAGERS -- Management Level Eligibility 
 Is Now Eligible For: ER1 -- Eligibility Rule 1 for testing 
    MANAGERS -- Management Level Eligibility 
 

 For e-mail notification to be successful, all e-mail settings must be set up and the 
HR Administrator assigned portal users Site Settings – Portal Users email address 
must exist for the employee. See the E-mail Setup section of this document for 
more information. 
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Example of e-mail sent to the employee when the employee’s eligibility 
conflict is resolved: 
 

From: someone@example.com 
Sent: Monday, July 19, 2004 4:02 PM 
To: someone@example.com 
Subject: Employee Eligibility Conflict Resolved 
 
Brenda Diaz: 
 
Your Eligibility has been assigned and your Benefit Enrollment options should 
now be available. You can access these options on the Business Portal; Employee 
- Benefits page. Please proceed with any open Benefit Enrollment selections. 
 
Thanks 
HR Administration 

 

 For e-mail notification to be successful, all e-mail settings must be set up and the 
Employee – Profile e-mail address must exist for the employee. See the E-mail 
Setup section of this document for more information. 

 
The Life Events Web Part allows the employee to submit a change in address, update 
their tax withholding form, add a change in marital status and add information about a 
new child. 
 
The Dependents Web Part will enable the employee to change the number of their 
dependants due to any life-changing event, such as the birth of a child, adopting a 
child, a marriage, a divorce or the death of a spouse/partner. 

Benefit Self Service User’s Guide 10 



Chapter 2: Benefits Summary 
The Benefits Summary page is accessed through the Benefits page. To obtain further 
information about the existing benefits you have, click the Existing Benefit link or the 
Additional Benefit Information link. 
 

 

 

Benefits Summary Overview 
The Benefits Summary page will open when you click the Existing Benefit link in the 
Benefits Summary web part. This page will allow you to view information on all active 
benefit codes you are currently enrolled in (based on the configuration established by 
the HR Administrator in the Benefit Rights – Closed Enrollment selections) and the 
status of the benefit code. The employee will also be able to view benefits they did not 
enroll in and those “given” or assigned to them by HR. All old “inactive” and new 
“pending” benefit codes will be listed. The most current (based on the latest changed 
date) of all records with a status of Active will be available for each benefit code for you 
to view. 
 

 

 
Benefit Summary Benefit Codes will display a list of all benefit codes and 
descriptions for active records. When you select a benefit code in the list, the tabs in 
the Benefit Summary Properties web part will display the information corresponding to 
the selected benefit record. 
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Benefit Plan Provisions: Pick this task below the Benefit Summary Benefits Codes 
web part to display links that have been set up for the selected Benefit Code. 
 
Summary tab will display employee benefit information related to the benefit code 
that is selected in the Benefit Summary Benefit Codes web part. The data displayed 
here will be viewable based on the benefit rights set up by the HR Administrator 
(defined later) and is view-only. The information here is the detailed information that is 
pulled from the back office (Microsoft Dynamics GP) for your viewing information. 
 

 

 
Pending Changes tab will display future effective setup information related to the 
benefit code that is selected in the Benefit Summary Benefit Codes web part. The data 
displayed here will be view-only based on the benefit rights set up by the HR 
Administrator (defined later). If no future effective record exists for the benefit code 
selected, the Pending Changes tab will display, “No Pending Changes”. You will be able 
to move back and forth from the Summary tab to the Pending Changes tab to see what 
information will change on the existing benefit in the future. 
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Employee Benefit Selection Overview 
The Employee Benefit Selection page will open when you click the Additional Benefit 
Information link in the Benefits Summary web part. This page will allow you to view the 
benefit selections before and after submission during the Annual Enrollment and 
Employee Enrollment process. 
 
 
 
 
 
 
 
 
 
 
 
 
The Benefits Not Yet Selected Web Part displays the benefits for which the 
employee is eligible, but has not yet selected during the Annual Enrollment or 
Employee Enrollment process. 
 
The Benefits Selected Web Part displays the benefits which have been selected, 
waived, or skipped by the employee during the Annual Enrollment and Employee 
Enrollment process. 
 
The Submitted for Approval Web Part displays the benefits that have been 
submitted and are waiting for approval from HR. 
 
The system allows the employee to print a Benefit Confirmation Statement, Benefit 
Selected Statement and Benefits Not Yet Selected Statement by benefit type or benefit 
selection process. 
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Chapter 3: Benefits Enrollment 
The Benefits Enrollment page is accessed by clicking the Annual Open Enrollment or 
Employee Enrollment links on the Benefits page in the Benefits Enrollment web part. 
You will only be able to access the Benefit Enrollment page when there is an open 
enrollment period set up by the HR Administrator for either Annual or Employee 
Enrollment. 
 

Benefits Enrollment Overview 
The Benefits Enrollment page is where you can review and make selections for any 
enrollment periods that are currently open. Benefit information to help the employee 
make decisions before starting the enrollment process is provided on the Details tab on 
the Annual or Employee Enrollment page. The actual enrollment selection process is 
managed in the Make Benefit Selections wizard that will step you through each benefit 
selection you choose to enroll in. You will be allowed to adjust and modify selections 
until you are ready to submit your final selections. 
 
After you have submitted the final selections for approval, you will be unable to access 
the Make Benefit Selections wizard, but you will still be able to view all the information 
you selected on the Benefits Enrollment page. You will also be able to review the 
selections you submitted via the report option. 
 

 

 
The Benefits Enrollment page has the following web parts. Each of these web parts will 
be described in more detail later in this document: 
 
• Benefit Types 
• Enrollment Properties 
 
Benefit Types will contain a list of benefit types defined and used by the Benefit Self 
Service application. These are: Health (Medical, Dental, Vision), Life and Disability, 
Retirement and Miscellaneous benefits. Only those types will show on the web parts 
that are available to that specific employee. 

Benefit Self Service User’s Guide 14 



Enrollment Properties includes four or five tabs dependant on the benefit type 
selected in the Benefit Types web part. 
 

Options tab will display view-only information of the employee’s eligible options 
based on the benefit type selected and the benefit package settings assigned, 
shown in the following illustration. 

 

 

 
The selections made in the wizards will be reflected on the Options tab of the 
Benefits Enrollment page. They will be designated by a red asterisk (*) and the 
associated radio button will be grayed out if the selection was enrolled or waived. 
If the skip option was selected, there will be no asterisk and the associated radio 
button will not be grayed out. This web part shows what benefit codes you 
selected through the wizard but still is not editable. 
 
Details tab will display view-only information of the employee’s eligible options 
based on the benefit type selected and the benefit package settings assigned, 
shown in the following illustration. 
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This tab will always display the current enrollment option record from the back 
office (as based on what will be current when this enrollment is actually posted 
to the back office). The system will determine which record (current core or 
future effective) is determined to be “current.” This is determined by looking at 
the date (default effective date) entered on the Human Resources Center > 
Benefit Self Service Center Pages > Annual Open Enrollment Setup and/or 
Employee Enrollment Setup pages, and the effective dates of the future effective 
benefit code records in the back office. 
 
If the default effective date entered on the enrollment setup page is after or the 
same date as the future effective record, then the record displayed as “current” 
will be the future effective (pending) record. In this case it will also be displayed 
on the Details tab and nothing will show on the Pending Changes tab. However, if 
the default effective date entered on the enrollment setup page is before the 
date of the future effective record, then the record displayed as “current” will be 
the current record (not future effective) from the back office. In this case it will 
be displayed on the Details tab and the future effective record will be displayed 
on the Pending Changes tab. 
 
Pending Changes tab will display view-only information of the employee’s 
eligible options based on the benefit type selected and the benefit package 
settings assigned, shown in the following illustration. 

 

 

 
This tab will display the future effective record from the back office for the 
specified benefit code. If no future effective record exists for the code, then a 
message will display “No Pending Changes.” 

 
If the Details tab displays the future effective record, shown in the above 
illustration, it will not affect what displays on the Pending Changes tab. In that 
case, both will display the future effective record. 
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Dependents tab lists currently associated dependents for the enrolling 
employee. 

 

 

 
Beneficiaries tab lists currently associated beneficiaries for the enrolling 
employee. 
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Benefit Enrollment Wizard 
The Benefit Enrollment Wizard is launched by clicking the Make Benefit Selections task 
link located beneath the Benefit Type web part. 
 
When you click this link, the Open Enrollment Wizard will open for enrollment selections 
of the benefit type currently selected. You can click this link and change benefit 
selections for each benefit type multiple times. You can do this as many times as 
needed until the Submit Final Benefit Selections task is selected for that benefit type. 
 

  

 
Welcome Page 
The first page of the Benefit Enrollment wizard simply serves as a basic introduction to 
the benefit enrollment process and specifies which benefit type the benefit enrollment 
wizard is for. 
 
Select Benefit Options 
The Options page of the wizard allows you to enroll, waive or skip the benefit options 
listed. This is based on the eligibility rules and benefit packages the HR Administrator 
had previously set up. For instance, if the HR Administrator specifies this package is to 
be required, the column would read Waive, shown in the below illustration. If the HR 
Administrator specifies this package is not required, the column that displayed Waive 
would display Skip instead. 
 
Also, if this enrollment was set up as “multiple,” the wizard would display each of the 
benefit codes individually, allowing you to either enroll, or to waive or skip. This 
enrollment was set up to be “single,” so all benefit codes appear on this one window 
together opposed to a single enrollment for each separate benefit code. 
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This enrollment is a single selection and is required, meaning all benefit codes are on 
one window, requiring you to either enroll or waive. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 

Benefit Details 
This page allows you to review the plan details of the selection that you have made on 
the previous pages of the wizard. Fields will be viewable and/or editable on this window 
based on the benefit rights set up by the HR Administrator. 
 
Clicking Next will take you to the summary page or, if there are additional options in 
the package, to the next benefit available for selection. The wizard will take you 
through each option (and details if Enroll, Waive or Skip have been selected) that you 
are eligible to have for this benefit package. Once all packages have been finished, you 
will be taken to the Benefit Summary page of the wizard. 
 
Benefit Summary 
This is the final page of the wizard, which gives you the opportunity to review all of 
your selections for this package before clicking Finish. Clicking Finish only saves the 
record; it does not submit the record to HR. When you click Finish, you may go back 
into the wizard at any time during the enrollment period and make changes as long as 
you have not submitted your final selections. 
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Submit Final Benefit Selections 
When you have completed the enrollment wizard and you are absolutely certain of your 
selections, you are then able to click the Submit Final Benefit Selections link to prompt 
the Submit Final Selections window. 
 
Clicking the Submit Final Benefit Selections link will open the following page, as shown 
in the below illustration. 

 

  

 
On this page you are able to choose between the benefit types that you have made 
selections for, but haven’t submitted final selections for. For the example above, you 
have made selections and completed the wizard only for the Health Benefit Type. After 
you enter your electronic signature and click Submit, your selections are sent to HR for 
approval. You will see only those benefit types that have been fully completed through 
the wizard. You may submit all benefit types or one by one as you so choose. 
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Part 2: Human Resources Benefits 
The Human Resources Benefits options must be set up and maintained and can be 
accessed by anyone assigned to the Benefit Self Service data permissions via Site 
Actions > Site Settings > Users and Permissions in Business Portal. Suggested setup 
would include only HR Administrator level rights to these options. 
 
The Human Resources Benefit options have been built to allow flexibility and ease of 
use to administer the many details related to employee eligibility, enrollment periods 
and packaging options. Wizards have been built in to assist in the administration of 
benefits available for employees, as well as administer employee access at the 
Employee > Benefits level in Business Portal. By navigating to Human Resources in 
Business Portal, the options that are provided – enrollment periods, benefit codes, 
employee eligibility and much more – can be easily maintained. 
 

  

 
Chapter 1: Benefit Rights, allows the HR Administrator access to the benefit view/edit 
rights, validations and benefit description assignments for each benefit code to be 
administered. 
 
Chapter 2: Benefit Packages, enables the HR Administrator to create benefit packages 
and default settings for use within the Eligibility Rules – Benefits selections. Inactivation 
setup is also maintained here. 
 
Chapter 3: Eligibility Rules, enables the HR Administrator to create and maintain 
eligibility rules that have benefit package and employee associations. Eligibility rules 
are the link between benefit options and employees. 
 
Chapter 4: Annual Open Enrollment Setup, allows the HR Administrator to create 
annual open enrollment periods and establish effective dates by benefit type.
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Chapter 5: Employee Enrollment Setup, allows the HR Administrator to create 
employee-specific open enrollment periods and establish effective dates by employee 
and by benefit type. 
 
Chapter 6: Enrollment Summary, allows the HR Administrator to view both the Annual 
Enrollment and Employee Enrollment benefit summary and details.  
 
Chapter 7: Post Employee Enrollment, provides a way for the HR Administrator to post 
the employee enrollment benefit selections to the back office. 
 
Chapter 8: Post Annual Open Enrollment, is meant to provide a way for the HR 
Administrator to post the employee annual enrollment benefit selections to the back 
office. 
 
Chapter 9: Delete Enrollment Utility, is meant to provide a way for the HR 
Administrator to review and delete employees benefit selections that have not yet been 
posted to the back office. 
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Chapter 1: Benefit Rights 
 

Benefit Rights Overview 
The Benefit Rights page is where benefit view/edit rights, validations (maximums) and 
individual documents for each benefit code can be set up. The benefit rights option 
allows configuration of view/edit access to individual fields for benefit enrollment and 
benefit summary options, for each benefit code. It also gives you flexible options for 
setting field validations and assignment of the benefit description using an Adobe 
Portable Document Format (PDF) file. 
 
The Benefit Rights page is accessed by clicking the Benefit Rights link on the Human 
Resources page under Benefit Self Service Center in the task pane. 
 

  

 
The Benefit Rights page consists of the following web parts. Each of these web parts is 
defined in more detail later in this document: 
 
Benefit Rights Benefit Codes Web Part updates individually with different 
information based on the benefit type of the benefit code selected. The information to 
be viewed/edited and some of the validations information is pulled from the back office. 
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Benefit Rights Properties Web Part includes three tabs for each benefit code – 
Rights, Validations and Documents. 

 

  

 
Rights tab will display a list of attributes that are available to define view/edit 
rights for each benefit type. When a benefit code is selected from the Benefit 
Rights Benefit Codes list, the benefit type associated with that benefit code will 
determine which attributes are available to choose from.  
 
You will be able to select Enrollment Access Rights and Benefit Change Access 
Rights view/edit options as desired on the Rights tab. Within the Enrollment 
Access Rights columns, if the attribute is view-only, the Edit check box option will 
not be available. The Benefit Change Access Rights view/edit selections apply to 
the employee options in the Benefits Summary page web parts for existing 
benefits. The Edit feature for these attributes does not affect the existing 
benefits. The Enrollment Access Rights view/edit selections apply to the 
employee options in the Benefit Enrollment page web parts. 
 
Validations tab will display either view-only or editable fields of specific 
validations set in the back office Human Resources Benefit Setup window for the 
benefit code selected. Depending on the benefit type, the fields and edit/display 
on this Validations tab will vary. If there is a future effective record in back office 
for the benefit code selected, then these values will show up in the Pending 
Validations area. These validations are implemented when the employee enrolls 
through the Make Benefit Selections wizard if chosen. 
 

 In Benefit Self Service open enrollment, benefit codes look for age 
information to determine if an employee or dependent is eligible to be 
enrolled from the age on the Type Benefit Codes Setup window. A 
maximum age must be defined for the employee and dependent in the 
back office for each benefit type. 
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Documents tab will allow the HR Administrator to associate a PDF file to a 
specific benefit code selected. The HR Administrator must work with the Business 
Portal Administrator to upload new files or update existing files and load them 
onto the server, while communicating the correct location of those files in order 
to make the necessary file association in this option. 
 
The PDF files assigned here will be available as links for the benefit code in both 
the Benefits Summary and Benefit Enrollment options. On this page, when the 
Preview button is clicked, and in the employee options when the link is clicked, 
the PDF file will open on another page that allows you to view, print and save the 
file. 
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Chapter 2: Benefit Packages 
 

Benefit Packages Overview 
The Benefit Packages page is where benefit packages and default settings can be 
created for use in the Eligibility Rules – Benefits selections and where the default 
requirements can be set. 
 
• Examples of Health packages: Major Medical, Vision, Dental 
• Examples of Life and Disability packages: Supplemental, Voluntary, Accidental 

Death & Dismemberment 
• Examples of Retirement packages: 401k, 529 Plan, Employee Stock Ownership 

Program 
• Examples of Miscellaneous packages: Charity, Flex, Savings, United Way 
 
In order for an employee to enroll in a benefit code, they must be assigned to an 
eligibility rule. That eligibility rule is assigned benefit packages to allow for proper 
administration to the employee. If a company has only one set of selections for a type, 
they should create a package named the same as the benefit type that includes all of 
their options. For example, if there is only one retirement plan available, they could 
create a benefit package of “Retirement” and when they use this in the eligibility rules, 
they could assign the package which contains that one benefit code to the group of 
people who are eligible for “Retirement.” 
 
This page can be accessed by choosing Human Resources > Benefit Self Service Center 
> Benefit Packages. 
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The Benefit Packages page consists of the following web parts. Each of these web parts 
is defined in more detail later in this document: 
Benefit Packages will contain a list of the four benefit types defined and used by the 
Benefit Self Service application. These are Health, Life and Disability, Retirement and 
Miscellaneous. 
 
Benefit Package Properties includes two tabs for the selected benefit package – 
Common and Inactivation Setup. 
 

Common tab will contain the default settings for the benefit package code 
selected in the Benefit Packages list. When the HR Administrator selects a record 
from the Benefit Packages list, the information corresponding to that record will 
be displayed in the Benefit Package Properties web part. If the HR Administrator 
makes changes to the Description field, they must click Save to save the changes 
to the table. Once the HR Administrator creates the package, the only 
information that can be updated on the Common tab is the Benefit Package 
Description, Employee Selection Required and Benefit Code Selections fields. 
 

  

 
Inactivation Setup tab will offer the HR Administrator the ability to set up 
codes to stay active or become inactive based on the type of enrollments that 
have been determined. As shown in the following illustration, these are all 
Miscellaneous benefit codes. To get these codes set up the way they appear 
here, you must click Modify and then you can select whether to inactivate or 
leave active each code that is associated. 
 
The Inactivate or Leave Active options apply to the existing benefits the 
employee is enrolled in prior to the new enrollment selections being posted to 
the back office. Any new enrollments posted to the back office are posted as 
Active, depending on the setup. 
 
Inactivation is applied at the employee level, so this setup will only have an 
effect if the benefit code exists for the employee and the employee has enrolled 
in the benefit code. As shown in the following illustration, the existing CHD 
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record is set to Inactive once the HR Administrator posts back. The CHD code for 
the new enrollment will become the active record in the back office if the 
employee chooses to enroll again this plan year. If the employee does not elect 
to enroll in CHD, they will not see the CHD code on the Existing Benefits page. 
 
As shown in the following illustration, if the employee was enrolled in EPU and 
does not re-enroll in the EPU benefit when their current enrollment benefit 
selections are posted to the back office, the EPU benefit code will be left as an 
active benefit for that employee. Any deductions that are associated with EPU 
will remain or, if there was an increase or decrease to the benefit, those changes 
will automatically take place. 
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Create a Benefit Package Wizard 
The Create Benefit Package link on the Benefit Packages page will launch the Create a 
Benefit Package wizard. Each step in the wizard is described below in detail. 
 

Welcome Page 
This page welcomes you to the Create a Benefit Package wizard and defines the 
purpose of this wizard, along with some detailed instructions. 

 
Select Benefit Type Page 
This page allows you to select the benefit type to create a package for. The four 
benefit types listed in this option are Health, Life and Disability, Retirement and 
Miscellaneous. Multiple benefit packages per benefit type can be created. 

 
Enter Benefit Package Code and Description Page 
This page allows you to enter the code and description to use for the new benefit 
package they are creating. The code can only be changed by deleting the 
package and creating a new code. The description may be changed at any point 
in the setup. 
 
Select Benefit Package defaults Page 
The selections made on this page will be used as defaults in the Eligibility Rule – 
Assign Benefit Packages wizard: 

 
Employee Selection Required: (Yes/No). The default setting should be 
Yes. 
• If you select Yes, when you step through the Make Benefit Selections 

wizard, you will be required to waive or select a benefit code to enroll 
before continuing through the wizard. The Next button is not available 
until a benefit code is selected to enroll or waive. 

 
• If you select No, when you step through the Make Benefit Selections 

wizard, you will NOT be required to perform any action before continuing 
to the next wizard page. The Next button will be available regardless of 
whether a benefit code is either enrolled or skipped. In this step, you will 
have the option to enroll or skip. 

 
Benefit Code Selections: (Single/Multiple). The default setting should 
be Single. 
• If you select Single, when you step through the Make Benefit Selections 

wizard, you will be allowed to enroll, waive or skip only ONE of the benefit 
codes assigned to that benefit package. If you choose to waive this 
benefit, you can either waive or skip for all. The single selection option will 
allow you to choose only one radio button regardless of the choice. 

 
• If you select Multiple, when you step through the Make Benefit Selections 

wizard, you will be taken through each benefit code assigned to that 
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benefit package one by one. For example, if SUPP1 and SUPP2 are two 
benefit codes assigned to a benefit package called Supplemental Life, you 
will first see a wizard page with the SUPP1 selection. If selected, you will 
be taken to the detail page for SUPP1, likewise taken to the SUPP2 
selection page and so on. The wizard is not complete and will not close out 
until all packages have been completed within that particular benefit type. 

 
Summary Page 
The Summary page displays a summary of the selections made for this benefit 
package. When the HR Administrator clicks Finish, a benefit package record will 
be created only if a choice of Enroll or Waive was selected. No record is created 
for the choice of Skip. 

 
Remove Benefit Packages 
Clicking the Remove Benefit Packages link on the Benefit Packages page will open the 
Remove Benefit Package page with the message, “Are you sure you want to remove the 
selected Benefit Package?”. This enables the HR Administrator to delete benefit 
packages. Click Yes to remove the package. 
 

 A benefit package cannot be deleted if it is currently being used (not assigned) 
in an eligibility rule. If you attempt to remove a package while an enrollment is 
in progress, the assigned package will not be allowed to be deleted and a 
message appears. 

Benefit Self Service User’s Guide 30 



Chapter 3: Eligibility Rules 
 

Eligibility Rules Overview 
The Eligibility Rules page enables the HR Administrator to create and maintain eligibility 
rules that will determine which groups of employees are eligible or those that need to 
be assigned to the various benefit packages available. 
 

  

 
The Eligibility Rules page consists of the following web parts. Each of these web parts is 
defined in more detail later in this document: 
 
Eligibility Rules is a list of all eligibility rules that have been created by the HR 
Administrator in the company. Since eligibility rules are the link between employees 
and benefit packages for open enrollment, selecting an eligibility rule from the Eligibility 
Rules list will update the Eligibility Rules Properties web part area with the 
corresponding information. 
 
Eligibility Rules Properties includes seven tabs for the Eligibility Rules – Common, 
Criteria, Employees, Health, Life and Disability, Retirement and Miscellaneous. 
 

Common tab will display the details of the eligibility rule selected in the 
Eligibility Rules list and enables you to change only the Eligibility Rule Description 
field. This tab is the default selection when this page is opened, as shown in the 
previous illustration. 
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Criteria tab will display the options that allow the HR Administrator to select the 
eligibility criteria that will be applied to a group. The criteria can either be List 
Based or Range Based. More than one criterion can be selected to narrow down 
the pool of employees. 
 

  

 
Clicking Modify in either area will open the Criteria Modify page. This page will 
enable you to assign specific items to any of the List or Range Based criteria that 
will identify the right group of employees for this eligibility rule. 
 
As shown in the following illustration, the ACCT (Accounting) department has 
been selected to classify those individuals who work in the Accounting 
department. This selection will limit the employee’s eligibility rule to anyone who 
has ACCT set as their home department and meets all other criteria set for this 
eligibility rule, if any. 
 

  

 
Clicking Modify on the Criteria – Range Based page will enable you to assign 
specific ranges to any of the range based criteria that will apply to the eligibility 
rule. 
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As shown in the following illustration, Years of Service criteria has been selected 
and a range of 0 to 12 years has been applied. This selection will limit the 
employees eligible for this eligibility rule to anyone who has an adjusted hire 
date equal to or within 0 to 12 years based on the current date. If no adjusted 
hire date is assigned, the criterion is based on the years of service from the 
original hire date. 

 

 The Include check box must be selected to enable these criteria range 
fields. When Include is cleared, the fields are not available and the values 
will be deleted when Save is clicked. 

 

  

 
Employees tab allows the HR Administrator to view and assign all current 
employees to an eligibility rule. The HR Administrator may also add or remove 
employees assigned to an eligibility rule by clicking Modify. The first time this is 
set up, no employees will be displayed. To assign employees for the first time, 
click the Employees tab and click Modify or click the Employee Eligibility Tool link 
in the Pick a task area. 

 
An employee cannot be assigned to more than one eligibility rule. If an employee 
is already assigned to a different eligibility rule and is assigned to a new 
eligibility rule, the existing eligibility rule record will be overwritten. The eligibility 
rule that the employee is currently assigned to will be displayed in a column next 
to the employee in the Employees tab list as shown below. 
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Clicking Modify will open the Employee Eligibility Tool page. This page will enable 
you to assign employees to eligibility rules. View the Employee Eligibility Tool 
section for more detail. 
 
Health tab will enable the HR Administrator to assign Health type benefit codes 
to a benefit package via the eligibility rules created. By clicking the Assign 
Benefit Packages link in the Pick a task area, the HR Administrator will be taken 
through the benefit code assignment and configuration using the Assign Benefit 
Package wizard. All selections made in the Assign Benefit Package wizard will be 
displayed on the benefits tabs of the Eligibility Rules page. 
 

  

 
Clicking Benefits will open a list of benefit codes that have been assigned to the 
selected benefit package. 

 

Remove Benefit Packages 
Clicking the Remove Benefit Packages link will open the Remove Benefit 
Package page and display the message, “Are you sure you want to remove 
the selected Benefit Package?”. This enables the HR Administrator to 
delete benefit packages. Click Yes to remove the package. 
 
Modify Benefit Packages 
Clicking the Modify Benefit Packages link will open the Modify Benefit 
Packages wizard. This allows the HR Administrator to modify the settings 
and benefit codes assigned to the selected benefit package. 
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Life tab will enable the HR Administrator to assign Life and Disability type 
benefit codes to a benefit package via the eligibility rules created. By clicking the 
Assign Benefit Packages link in the Pick a task area, the HR Administrator will be 
prompted to complete the benefit code assignment and configuration using the 
Assign Benefit Package wizard. All selections made in the Assign Benefit Package 
wizard will be displayed on the benefits tabs of the Eligibility Rules page. 
 

  

 
Clicking Benefits will open a list of benefit codes that have been assigned to the 
selected benefit package. 

 

Remove Benefit Packages 
Clicking the Remove Benefit Packages link will open the Remove Benefit 
Package page and display the message, “Are you sure you want to remove 
the selected Benefit Package?”. This enables the HR Administrator to 
delete benefit packages. Click Yes to remove the package. 
 
Modify Benefit Packages 
Clicking the Modify Benefit Packages link will open the Modify Benefit 
Packages wizard. This allows the HR Administrator to modify the settings 
and benefit codes assigned to the selected benefit package. View the 
Modify Benefit Packages section for more detail. 
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Retirement tab will enable the HR Administrator to assign Retirement type 
benefit codes to a benefit package via the eligibility rules created. By clicking the 
Assign Benefit Packages link in the Pick a task area, the HR Administrator will be 
prompted to complete the benefit code assignment and configuration using the 
Assign Benefit Package wizard. All selections made in the Assign Benefit Package 
wizard will be displayed on the benefits tabs of the Eligibility Rules page. 
 

  

 
Clicking Benefits will open a list of benefit codes that have been assigned to the 
selected benefit package. 

 

Remove Benefit Packages 
Clicking the Remove Benefit Packages link will open the Remove Benefit 
Package page and display the message, “Are you sure you want to remove 
the selected Benefit Package?”. This enables the HR Administrator to 
delete benefit packages. Click Yes to remove the package. 

 
Modify Benefit Packages 
Clicking the Modify Benefit Packages link will open the Modify Benefit 
Packages wizard. This allows the HR Administrator to modify the settings 
and benefit codes assigned to the selected benefit package. View the 
Modify Benefit Packages section for more detail. 
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Miscellaneous tab will enable the HR Administrator to assign Miscellaneous 
benefit type benefit codes to a benefit package via the eligibility rules created. By 
clicking the Assign Benefit Packages link in the Pick a task area, the HR 
Administrator will be prompted to complete the benefit code assignment and 
configuration using the Assign Benefit Package wizard. All selections made in the 
Assign Benefit Package wizard will be displayed on the benefits tabs of the 
Eligibility Rules page. 
 

  

 
Clicking Benefits will open a list of benefit codes that have been assigned to the 
selected benefit package. 

 

Remove Benefit Packages 
Clicking the Remove Benefit Packages link will open the Remove Benefit 
Package page and display the message, “Are you sure you want to remove 
the selected Benefit Package?”. This enables the HR Administrator to 
delete benefit packages. Click Yes to remove the package. 
 
Modify Benefit Packages 
Clicking the Modify Benefit Packages link will open the Modify Benefit 
Packages wizard. This allows the HR Administrator to modify the settings 
and benefit codes assigned to the selected benefit package. View the 
Modify Benefit Packages section for more detail. 
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Create Eligibility Rule Wizard 
The Create an Eligibility Rule wizard allows the HR Administrator to create unique codes 
and descriptions to group employees and the associated benefit packages to manage 
benefit selection and enrollment for the employees. The eligibility rule codes and 
descriptions are determined by the company’s policies. If there are no different benefit 
groups within a company, a general eligibility rule must be created that includes all 
employees. An employee cannot participate in open enrollment without being assigned 
to an eligibility rule. Each step in the wizard is described below in detail. 
 
Welcome Page 
This page welcomes you to the Create an Eligibility Rule wizard and defines the purpose 
of this wizard. 
 
Enter Eligibility Rule Code and Description Page 
This page allows you to enter the code and description for the eligibility rule that is 
being created. 
 
Summary Page 
This page displays a summary of the selections made for this eligibility rule. Click Finish 
to complete the eligibility rule creation. 
 

Assign Benefit Packages Wizard 
The Assign Benefit Packages wizard will prompt the HR Administrator to assign and 
configure benefit packages and benefit codes for the eligibility rule. Each step in the 
wizard is described below in detail. 
 
Welcome Page 
This page welcomes you to the Assign Benefit Packages wizard and defines the purpose 
of this wizard. 
 
Select Benefit Type Page 
This page allows you to select the benefit type to assign a package for. The four benefit 
types listed in this option are Health, Life and Disability, Retirement and Miscellaneous. 
 
Select Benefit Packages 
This page allows you to select the benefit package to assign to this eligibility rule. The 
list of benefit packages will be limited based on the benefit type selected in the 
previous page of the wizard. Multiple benefit packages per benefit type can be set up 
within an eligibility rule, but each benefit package must be assigned individually. 
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Select Benefit Codes 
This page allows you to assign any benefit codes (that match the benefit type) to the 
selected benefit package.  
 
You will not be allowed to assign the same benefit code to more than one benefit 
package within the same eligibility rule. If a benefit code is already assigned to another 
benefit package for that same eligibility rule, the benefit code option will not be 
available. However, this does not restrict the ability to assign the same benefit package 
to more than one eligibility rule. 
 
Define Benefit Package Settings 
This page allows you to select the benefit package settings to assign to this eligibility 
rule. The same benefit package can be assigned to multiple eligibility rules, but the 
information (benefit codes and settings) are unique to that eligibility rule and benefit 
package combination.  
 
Defaults will come in based on the benefit package setup information but you can 
change them for each package: 

 
Employee Selection Required: (Yes/No). 
• If you select Yes, when you are prompted to complete the Make Benefit 

Selections wizard, you will be required to waive or select a benefit code to 
enroll before continuing to the next wizard page. The Next button is not 
available until a benefit code is selected to enroll or waive. 

 
• If you select No, when you are prompted to complete the Make Benefit 

Selections wizard, you will be required to skip or select a benefit code to 
enroll before continuing to the next wizard page. The Next button is not 
available until a benefit code is selected to enroll or skip. 

 
Benefit Code Selections: (Single/Multiple). 
• If you select Single, when you are prompted to complete the Make Benefit 

Selections wizard, you will be allowed to select only ONE of the benefit codes 
assigned to that benefit package. 

 
• If you select Multiple, when you are prompted to complete the Make Benefit 

Selections wizard, you will be stepped through each benefit code assigned to 
that benefit package one by one. For example, if SUPP1 and SUPP2 are two 
benefit codes assigned to a benefit package called Supplemental Life, you will 
first see a page with the SUPP1 selection. If selected, you will be taken to the 
detail page for SUPP1, then to the SUPP2 selection page and so on. 

 
Summary 
This page displays a summary of the selections made for this benefit package as 
assigned to this eligibility rule. When the HR Administrator clicks Finish, this record will 
display on the benefits tabs (Health, Life and Disability, Retirement and Miscellaneous) 
on the Eligibility Rules page. Any further modifications or deletions of the benefit 
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packages assigned to this eligibility rule are handled via the action options found on the 
benefits tabs on the Eligibility Rules page. 
 

Employee Eligibility Tool 
An employee must be assigned to an eligibility rule to access a Benefit Enrollment. The 
Employee Eligibility Tool will enable you to easily assign employee eligibility and resolve 
any eligibility conflicts. Each feature of the tool is defined below. 
 

 

 
It is recommend that when you are initially setting up your eligibility rules that you 
complete the creation of all of your eligibility rules and their criteria before assigning 
the employees. We also recommend that you verify any eligibility conflicts at this time 
by using the tool any time you make changes to any of your eligibility rules criteria. 
 
Apply Filter is a feature of the Employee Eligibility Tool provided to enable easy search 
capabilities. Multiple options are available to help you narrow down or broaden the 
search as needed. Once the appropriate selections are made, clicking Apply Filter will 
update the results in the scrolling window. 
 
Eligibility Rule will default to the selected eligibility rule when you open the Employee 
Eligibility Tool, and the results in the scrolling window will reflect this filter. This option 
allows you to select any other specific eligibility rule or choose All. 
 
Employee ID/Last Name allows you to search on a specific or partial employee ID or 
last name. Enter the text you want to search on (example: Smith) and when you click 
Apply Filter, the results in the scrolling window will reflect this filter. In the example of 
Smith, it will return all employees whose last names contain Smith and all employees 
whose IDs contain Smith. 
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Assignments allows you to filter the results by all employees, employees who are 
currently assigned to an eligibility rule, employees who are currently assigned to an 
eligibility rule that they are not eligible for or employees who are currently unassigned 
to any eligibility rule. 
 
Conflict/Override allows you to filter the results by all employees, employees who 
have been saved as overrides or employees whose current eligibility is in conflict. 
Eligibility conflict is defined as any employee who is not eligible for any eligibility rules 
or any employee who is eligible for more than one eligibility rule. Until a conflict is 
resolved by assigning an eligibility rule or setting the override option for an employee 
on this page, the employee will be unable to access their benefit enrollment options. 
 
Eligibility Changes allows you to filter the results by all employees, employees whose 
eligibility has changed or employees whose eligibility has not changed.  
 
Assign to all Matched Employees provides a way for you to quickly assign a specific 
eligibility rule to the employees selected by your current apply filter results. This 
feature is especially useful when only one eligibility rule exists for your company 
because you can apply filter results for all employees, select your eligibility rule in the 
Assign to all Matched Employees field and click Apply Filter. When you save the 
selections, all your employees have been assigned to the eligibility rule. 
 
View Page allows you to move within the pages of results in the scrolling window 
quickly. There are 20 employees that are displayed per page. In addition, the results 
can be sorted by ascending or descending order by either the Employee ID column or 
the Last, First Name column by clicking the column heading. Using the sorting and View 
Page options, you can quickly navigate to the page that contains the specific employee 
you are searching for. 
 
Eligible For in the scrolling window is designed to give you the information you need 
to determine the eligibility of any employee. The column will display all eligibility rules 
that the employee is eligible for. 
 

 Eligibility is defined as matching ALL criteria assigned. If multiple criteria 
are set up for an eligibility rule, the employee’s data must match all the 
criteria to be automatically eligible for that eligibility rule. 

 
Assigned in the scrolling window is where you select the eligibility rule that the 
employee will be assigned to. The list contains all the eligibility rules you have set up. 
You are not limited to assigning only eligibility rules to an employee if the employee is 
eligible for the rules based on the criteria set. 
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Override in the scrolling window is available for those exceptions to the rule, if an 
employee is eligible for a certain eligibility rule regardless of their current employment 
status. 
 

 If the Override option is selected for an employee, changes to their 
eligibility will not be verified. To make any changes to that employee’s 
assigned eligibility, you must make the change on the Employee Eligibility 
Tool page. The option is provided but each company is responsible for 
using it in a manner that does not violate any rules or regulations set by 
their business rules, provider rules or the laws of the state or federal 
government. 

 
Save/Email Notification allows you to save all changes and selections made in the 
Employee Eligibility Tool. 
 
If there are no conflicts that exist, an e-mail notification will be sent to that employee 
letting them know they are now eligible to enroll in their benefit enrollment options. 
 

 We recommend that you verify and resolve any employee eligibility 
conflicts before clicking the Save button. Select Conflicts in the 
Conflicts/Overrides field and click Apply Filter to view all conflicts. You 
may further narrow this search by selecting one of the Eligibility Changes 
or Assignment field options.  

 

 Save will update and save all employees eligibility records. It is 
recommended that only one HR or administrative user modify employee 
eligibility at one time. 

 
Example of e-mail sent to the HR Administrator when an employee is set to in 
“Conflict:” 

From: someone@example.com 
Sent: Monday, July 19, 2004 4:12 PM 
To: someone@example.com 
Subject: Employee Eligibility Conflict  
 
The following employee has an Eligibility conflict. Please resolve this Eligibility 
conflict using the Employee Eligibility Tool. 
 
Employee ID: DIAZ0001 
Employee Name: Diaz, Brenda 
 
Currently Assigned Eligibility: 
ER2 -- Eligibility Rule 2 
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Was Eligible For: 
ER1 -- Eligibility Rule 1 
ER2 – Eligibility Rule 2 
MANAGERS -- Management Level Eligibility 
 
Is Now Eligible For: 
ER1 -- Eligibility Rule 1 for testing 
MANAGERS -- Management Level Eligibility 

 

 For e-mail notification to be successful, all e-mail settings must be set up and 
the Employee – Profile e-mail address must exist for the employee. See the E-
mail Setup section of this document for more information. 

 
Remove Eligibility Rule 
When you click Remove Eligibility Rule in the Pick a task area of the Eligibility Rules 
page, the Remove Eligibility Rule page will be displayed, enabling the HR Administrator 
to delete eligibility rules and all their related employee and benefit package selections. 
 

 You cannot remove an eligibility rule that is assigned and has any unfinished 
enrollment selections for any employee. If you do attempt to delete with this 
condition, a message will appear after you click Yes to confirm the deletion. You 
will not be able to remove this eligibility rule until all enrollment selections for 
all employees assigned to this eligibility rule have been finished or the HR 
Administrator deletes all enrollments for that period. 

 

Modify Benefit Package wizard 
The Modify Benefit Package wizard will allow the HR Administrator to modify the 
settings and benefit codes assigned to the selected benefit package. The Modify Benefit 
Package wizard is available from a link on each benefit tab on the Eligibility Rules 
Properties page. Each step in the wizard is described below in detail. 
 
Welcome Page 
This page welcomes you to the Modify Benefit Packages wizard and defines the purpose 
of this wizard. 
 
Select Benefit Codes 
This page allows you to make changes to the benefit codes assigned to the selected 
benefit package. When you open this page, the benefit codes list will reflect the 
currently saved list. You then have the option of selecting additional benefit codes or 
clearing benefit codes that are currently assigned.  
 
You will not be allowed to assign the same benefit code to more than one benefit 
package within the same eligibility rule. If a benefit code is already assigned to another 
benefit package for that same eligibility rule, the benefit code option will not be 
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available. However, this does not restrict the ability to assign the same benefit code to 
more than one eligibility rule. 
 
Define Benefit Package Settings Page 
This page allows you to select the settings to assign to this benefit package. The values 
for the fields found on this page will reflect the currently saved selections. You do have 
the option of changing either of the fields and their values: 
 

Employee Selection Required: (Yes/No). 
• If you select Yes, when you are prompted to complete the Make Benefit 

Selections wizard, you will be required to waive or select a benefit code to 
enroll before continuing to the next wizard page. The Next button is not 
available until a benefit code is selected to enroll or waive. 

 
• If you select No, when you are prompted to complete the Make Benefit 

Selections wizard, you will be required to skip or select a benefit code to 
enroll before continuing to the next wizard page. The Next button is not 
available until a benefit code is selected to enroll or skip. 

 
Benefit Code Selections: (Single/Multiple). 
• If you select Single, when you are prompted to complete the Make Benefit 

Selections wizard, you will be allowed to select only ONE of the benefit codes 
assigned to that benefit package. 

 
• If you select Multiple, when you are prompted to complete the Make Benefit 

Selections wizard, you will be stepped through each benefit code assigned to 
that benefit package one by one. For example, if SUPP1 and SUPP2 are two 
benefit codes assigned to a benefit package called Supplemental Life, you will 
first see a page with the SUPP1 selection. If selected, you will be taken to the 
detail page for SUPP1, then to the SUPP2 selection page and so on. 

 
Summary 
This page displays a summary of the selections made for this benefit package as 
assigned to this eligibility rule. Clicking Finish will complete the changes to the benefit 
package. 
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Chapter 4: Annual Open Enrollment Setup 
 

Annual Open Enrollment Setup Overview 
The Annual Open Enrollment Setup page is where the HR Administrator defines 
enrollment periods (window of time) for companywide enrollment for each benefit type. 
 

  

 

  

 
The Annual Open Enrollment page consists of the following web parts: 
• Annual Benefit Types 
• Annual Open Enrollment Properties 
 
Annual Benefit Types allows the HR Administrator to select the benefit type they wish 
to set open enrollment periods for. The benefit types are: 

• Health 
• Life and Disability 
• Retirement 
• Miscellaneous Benefits 
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Annual Open Enrollment Properties contains the enrollment period information and 
is related to the benefit type currently selected in the Annual Benefit Types list. The 
dates entered here will affect the Employee > Benefits > Annual Open Enrollment web 
part options. 
 
The Default Effective Date selected will be the benefit start date assigned to this 
employee’s back office record when their enrollment selections are posted. 
 

Chapter 5: Employee Enrollment Setup 
 

Employee Enrollment Setup Overview 
The Employee Enrollment Setup page is where the HR Administrator defines enrollment 
periods for a specific employee based on benefit types. The reasons for employee 
enrollment periods vary, but regardless of the reason, an employee is given access to 
benefit enrollment options by defining their enrollment periods on the Employee 
Enrollment Setup page. 
 
If an employee has a marital status change or position change, the HR Administrator 
will be responsible for selecting the employee from the Active Employees list and then 
clicking the benefit type properties tabs that require an enrollment period to be defined. 
 
If an employee is set to an open enrollment period, they will be allowed to make 
selections using the Open Enrollment wizard. If the event requiring changes does not 
make changes to the benefit codes the employee is currently enrolled in, then an 
enrollment period does not have to be created. 
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The Employee Enrollment Setup page consists of the following web parts. Each of these 
web parts is defined in more detail later in this document: 
• Active Employees 
• Employee Enrollment Properties 
 
Active Employees allows the HR Administrator to select only one employee at a time 
to define an enrollment period for. Each employee can have a different enrollment 
period set for the four benefit types: Health, Life and Disability, Retirement and 
Miscellaneous. The employee list will contain only employees that are Active in the back 
office and those that are currently assigned to an eligibility rule. 
 
Employee Enrollment Properties includes four tabs for the benefit types: Health, 
Life and Disability, Retirement and Miscellaneous. Each of these tabs contains the same 
information and is related to the employee currently selected in the Active Employees 
list. Each employee can have different enrollment periods defined for any or all of the 
four benefit types represented by the four tabs. The Default Effective Date selected will 
be the benefit start date assigned to this employee’s back office record when their 
enrollment selections are posted by the HR Administrator. 

Chapter 6: Enrollment Summary 
 

Enrollment Summary Overview 
The Enrollment Summary page enables the HR Administrator to view and print the 
Benefit Summary for employees by Annual Enrollment and Employee Enrollment. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Enrollment Summary page consists of the following web parts. Each of these web 
parts is defined in more detail in this document: 
 
The Benefit Summary web part provides the HR Administrator a quick overview of 
each employee’s enrollment status. 
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The Enrollments web part is a list of all enrollment types including the benefit kind. 
Selecting an enrollment type will populate the Benefit Status web part area with the 
corresponding information. 
 
The HR Administrator also has the ability to print the following enrollment metrics: 

• Listing of employees who have not made a benefit selection for an Annual 
Enrollment or Employee Enrollment Period. 

• Listing of employees who have made benefit selections, but not submitted final 
for an Annual Enrollment or Employee Enrollment Period. 

• Listing of employees who have submitted final benefit selections, which have not 
been posted for an Annual Enrollment or Employee Enrollment Period. 

 
Benefit Status includes three tabs for Benefit Status – Not Selected, Selected/Not 
Submitted and Submitted. 
 

Not Selected will display a list of employees who have not selected the specified 
benefit for the enrollment type selected in the Enrollments web part. This tab is 
the default selection when this page is opened. As shown in the below 
illustration, Delaney has not completed the selection for Benefit Kind: INS1 and 
INS2. 
 
 
 
 
 
 
 
Selected/Not Submitted will display a list of employees who have selected the 
specified benefit for the enrollment type selected in the Enrollments web part but 
have not completed the submission process. As shown in the below illustration, 
Delaney has not completed the selection for Benefit Code: CHD, EPU, MED and 
UW. 
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Submitted will display a list of employees who have completed the submission 
process for the specified benefit for the enrollment type selected in the 
Enrollments web part. As shown in the below illustration, Delany has completed 
the selection for Benefit Code: INS.  
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Chapter 7: Post Employee Enrollment 
 

Post Employee Enrollment Overview 
This page will allow you to review and post employees benefit selections to the back 
office application. You will be able to review the employee selections by benefit type 
and post by benefit type. You will post all benefit codes for any given type for an 
employee at one time. For example, if you select a benefit code for BARR0001 that is a 
Life and Disability benefit type, then automatically all Life type benefits for BARR0001 
are selected. 
 
When you click Post on this page, the employee benefit selections will be posted and 
will immediately update the back office. At the time the employee’s benefit selections 
are posted, existing benefit codes for that employee will be inactivated based on the 
inactivation setup, sent to a history table and then overwritten by the new selections. 
See Inactivation Setup for more information. 
 
When employee benefit selections are posted from this page, the back office will create 
the appropriate HR record, as well as the Payroll benefit and Payroll deduction records. 
When these benefit records are created, the back office will use the default values from 
the current HR and Payroll setup level for that benefit code. Future effective HR and 
Payroll setup level benefit record information will not be used as defaults. Remember to 
activate any future effective records at this time that are associated with the enrollment 
period. 
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Chapter 8: Post Annual Open Enrollment 
 

Post Annual Open Enrollment Overview 
This page will allow you to review and post employees benefit selections to the back 
office application. As the HR Administrator, you will be able to review the employee 
selections by benefit type and post by type. Posting by type will “mass” post all of the 
selections made by type. 
 
When you click Post on this page, the employee benefit selections will be posted, and 
will immediately update the back office and be removed from the page. At the time the 
employee’s benefit selections are posted, existing benefit codes for that employee will 
be inactivated based on the inactivation setup, sent to a history table and then 
overwritten by the new selections. See Inactivation Setup for more information. 
 
When employee benefit selections are posted from this page, the back office will create 
the appropriate HR record as well as the Payroll benefit and Payroll deduction records. 
When these benefit records are created, the back office will use the default values from 
the current HR and Payroll setup level for that benefit code. Future effective HR and 
Payroll setup level benefit record information will not be used as defaults. 
 

 Depending on the number of employees and number of benefits enrolled for 
each benefit type, it may be necessary to make some changes to your default 
server/Internet Information Services (IIS) settings to view all records to be 
posted. See Benefit Self Service Installation Guide – Time Out Settings for 
more details about what settings to change and benchmarks to use. 
Remember to activate any future effective records at this time that are 
associated with the enrollment period. 
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Chapter 9: Delete Enrollment Utility 
 

Delete Enrollment Utility Overview 
This page will allow you to review and delete employees benefit selections that have 
not yet been posted to back office. The HR Administrator will be able to review the 
employee selections by benefit type and delete them. You can only delete all benefit 
codes for any given type for an employee at one time. Therefore, if the employee 
makes a mistake and has posted, you must delete the entire enrollment for the 
employee and they must start from the beginning. You are not permitted to delete just 
one type for that enrollment. 
 
When you click Delete on this page, the employee benefit selections will be deleted 
and, provided the current enrollment period is still open, the employee will immediately 
be able to make new selections as required. 
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Part 3: Setup Requirements 
The information in this section describes how you will set up requirements to enable full 
functionality and features for the Benefit Self Service application. 
 
Chapter 1: E-mail and Terminal Setup, describes all requirements to enable the 
eligibility e-mail notification available in the Benefit Self Service application. 
 

Chapter 1: E-mail and Terminal Setup 
E-mail setup requirements must be correctly set up for the Benefit Self Service e-mail 
notification to function. There are general setup requirements as well as requirements 
specific to receiving the HR Administrator e-mail, and separate requirements specific to 
receiving the employee e-mail. 
 
General e-mail setup requirements are values on the Set Up E-Mail page (From the 
Home page, select Site Actions > Site Settings > Business Portal Administration > E-
mail and Terminal Services) that must be set up correctly for the following two fields: 
 
• SMTP server to use for e-mail (Example: ServerName) 
• E-mail address to use for sending Business Portal messages (Example: 

someone@example.com) 
 

 Depending on the number of employees and number of benefits enrolled for 
each benefit type, it may be necessary to make some changes to your default 
server/Internet Information Services (IIS) settings to view all records to be 
posted. See Benefit Self Service Installation Guide – Time Out Settings for more 
details about what settings to change and benchmarks to use. Remember to 
activate any future effective records at this time that are associated with the 
enrollment period. 

 
HR Administrator e-mail setup requirements are two requirements that must be 
met: 
 
• You must be assigned to the Business Portal Human Resources Administrator role 
• Your e-mail address must be set up and valid 
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Example of an e-mail sent to the HR Administrator when an employee is set to 
in “Conflict:” 

From: someone@example.com 
Sent: Monday, July 19, 2004 4:12 PM 
To: someone@example.com 
Subject: Employee Eligibility Conflict 
 
The following employee has an Eligibility conflict. Please resolve this Eligibility 
conflict using the Employee Eligibility Tool. 
 
Employee ID: DIAZ0001 
Employee Name: Diaz, Brenda 
 
Currently Assigned Eligibility: 
ER2 -- Eligibility Rule 2 
 
Was Eligible For: 
ER1 -- Eligibility Rule 1 
ER2 – Eligibility Rule 2 
MANAGERS -- Management Level Eligibility 
 
Is Now Eligible For: 
ER1 -- Eligibility Rule 1 for testing 
MANAGERS -- Management Level Eligibility 
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Employee e-mail setup requirements are two requirements that must be met: 
• You must be assigned to the Employee advanced role with a valid back office 

employee ID 
• Your Employee Profile e-mail address must be set up and valid 
 
Example of an e-mail sent to an employee when the employee’s eligibility 
“Conflict” is resolved: 

From: someone@example.com 
Sent: Monday, July 19, 2004 4:02 PM 
To: someone@example.com 
Subject: Employee Eligibility Conflict Resolved 
 
Brenda Diaz: 
 
Your Eligibility has been assigned and your Benefit Enrollment options should 
now be available. You can access these options on the Business Portal; Employee 
- Benefits page. Please proceed with any open Benefit Enrollment selections. 
 
Thanks 
HR Administration 
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Part 4: Employee Dependents and Beneficiaries 
The information in this section describes how employees will access and update the 
Dependents and Beneficiary pages. Both functions can be linked to individual benefit 
codes by the Human Resources Administrator to be included in the enrollment process. 
During the Annual or Employee Enrollment process, employees will have the option to 
select the specific benefit codes linked to a dependent and/or beneficiary. Employees 
will also be able to manage the Dependent data elements only on the Employee and 
Benefits pages. 
 
Chapter 1: Employee Dependents, will be available to any employee assigned to the 
Employee role in Business Portal. 
 
Chapter 2: Employee Beneficiaries, will be available to any employee who is eligible for 
benefits that can be linked to a specific benefit code. 
 

Chapter 1: Employee Dependents 
Dependents can be accessed in Business Portal by choosing Employee > Benefits > 
Dependents. 
 

Employee Dependents Overview 
The Dependent page is displayed through Employee > Benefits in Business Portal. To 
update this page, the employee will select add/modify/delete. 
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To Add a Dependent, choose Add… type pertinent information and select Submit. 
 

 

 
To Modify a Dependent, choose Modify… update information and select Submit. 
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To Delete a Dependent, choose Delete… type signature as noted and select Delete. 
 

  

 

 When an employee modifies Dependent information, the additions or changes 
will go through the workflow approval process before they will display in the 
portal. 

 

Benefit Self Service User’s Guide 58 



The following steps link the qualified Benefit Codes to the Dependent and Beneficiaries 
selection option. Navigate to Microsoft Dynamics GP menu > Tools > Setup > Human 
Resources > Benefits and Deductions > Health, Life, Retirement or Miscellaneous Setup 
window. By using the lookup option, select a Benefit Code, then select the GoTo option 
and select Benefit Options. 
 

  

 
Enter the maximum number of Dependents allowed for the selected benefit code. The 
example of 99 below demonstrates there are no limits on the number of Dependents or 
Beneficiaries that can be linked. 
 

 

 
Next, navigate to Microsoft Dynamics GP menu > Tools > Setup > Human Resources > 
Plan Status Reasons. Plan Status Reasons allows the employee to select an event that 
would result in an addition or deletion of a Dependent or Beneficiary per Benefit Code. 
Life change events are listed in the Plan Status Reason for each applicable Benefit 
Code. 
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As show in the following illustrations, the Plan Status Reasons for a Beneficiary and 
Dependent that is no longer qualified to receive the benefit has been setup for 
“Inactive”. To set up the “Inactive” you choose the Record Type, Status Type and then 
based on your companies policies, you put the cursor in the blank space provided and 
type in your own Status Reasons. As shown in the following illustrations there are 4 
Plan Reasons that were created for example purposes. Once you create your examples, 
then check the corresponding box and select OK. These Plan Status Reasons will show 
up in the Portal when you begin the enrollment process. 
 

  

 
As shown in the following illustration, the Plan Status Reasons for a Beneficiary and 
Dependent that is qualified to receive the benefit has been setup for “Active”. To set up 
the “Active” you choose the Record Type, Status Type and then based on your 
companies policies, you put the cursor in the blank space provided and type in your 
own Status Reasons. As shown in the following illustration, there are 4 Plan Reasons 
that were created for example purposes. Once you create your examples, select OK. 
These Plan Status Reasons will show up in the Portal when you begin the enrollment 
process. 
 

  

 
During the Open Enrollment process the employee chooses the Benefit Type and selects 
from options presented. The employee must choose “Submit Final Benefit Selections” in 
the lower left of the window before Dependents can be linked to the Benefit selections. 
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Returning to the Employee Enrollment window, the employee will then be able to 
access the Dependents tab to the Benefit selections. The selected Benefit Codes will be 
asterisked in the drop down window and the Dependents names will be listed with 
selection check boxes. 
 

 

 If a Benefit Code has not been linked to dependent options through the Benefit 
Options window then the error message below in red will populate during 
enrollment “Dependents cannot be assigned to the Benefit. Please contact your 
administrator.” 
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The employee will select the check box to assign a Dependent to the code, choose the 
appropriate status change reason, and then Save. The employee is required to link the 
Dependent to each asterisked Benefit Code. 
 

 

 

 Dependents can be modified in the Enrollment window at any time until the final 
submission. 
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Chapter 2: Employee Beneficiaries 
Beneficiaries can only be updated through Business Portal through an Employee or 
Annual Open Enrollment process. 
 

Employee Beneficiaries Overview 
Beneficiaries are linked to Life and Disability and Retirement benefits during enrollment. 
Beneficiaries entered through the enrollment process will be recorded in Microsoft 
Dynamics GP during the final posting process. 
 
During the Open Enrollment process the employee chooses the Benefit Type and selects 
from options presented. The employee must choose “Submit Final Benefit Selections” in 
the lower left of the window before Beneficiaries can be linked to the Benefit selections. 
After enrolling in the Life and Disability as seen below, select the Beneficiaries tab. 
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Returning to the Employee Enrollment window, the employee will then be able to 
access the Beneficiaries tab to make the Benefit selections. The selected Benefit Codes 
will be asterisked in the drop down window and the Beneficiaries. The employee will 
choose from the Benefit Code drop down and elect Modify. 
 

  

 
After selecting Modify, the Modification window will show. Beneficiaries that have been 
assigned to the Benefit Code previously will appear in this window. If there are no 
Beneficiaries assigned, the window will appear blank, as in the following illustration. 
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The employee selects Add in the top right of the window, enters the pertenint 
information and selects Save. The date field can be populated using the calandar popup 
or entered directly. Employee must save each beneficiary and then close window 
through top right X. 
 

  

 
Once the Beneficiaries have been added and saved, they will show on the Beneficiaries 
tab. The link to the Benefit Code is made when the employee selects “Active” for each 
employee. 
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Employee then assigns Primary and Secondary status and percentage of benefit. 
 

 

 

 If the total of Primary and Secondary beneficiaries’ allocation does not equal 
100%, a message will remind you to adjust your selections. 

 
After each benefit type has been linked to associated Beneficiaries employee selects 
“Submit final Benefit Selections” in the lower left of the window. 
 

 

 

 Beneficiaries can be modified in the Enrollment window at any time until the 
final submission. When the HR Administrator posts the Dependent and 
Beneficiary information will update the back office. 
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